A GUIDE TO REPRODUCTION
A PRIMER ON XEROGRAPHY, SILKSCREENING AND OFFSET PRINTING

by
RON REGE JR.
DAVE CHOE
BRIAN RALPH

&
JORDAN CRANE

And being a public service of reddingk and Highwater Books
I know there are lots of resources out there that instruct people on how to publish zines, but we are talking specifically about mini comics here, so I am going to try to give ya some tips that I’ve figured out while creating mini comics over the past 10 years.

Whenever I get excited about comics these days, it’s usually about mini comics. I may be excited about discovering a new cartoonist that I’ve never seen before, but often it’s the presentation of the comic that I’m being impressed by. The world of mini comics is so special because it’s about an artist creating the entire object. It is not only about the cartoonist's work, but also about the entire presentation of the work. The best mini comics in my collection are the ones that would not be the same when presented in any other format. Therefore, I encourage people to think about the presentation of the entire book, and not just about the comics within.

There are infinite numbers of ways of going about creating a mini comic. You are only limited by the amount of work you want to put into it. The copying, folding, cutting and stapling of the comic can take up more time than actually drawing it. It's up to you how much time you want to spend.

It all depends what you're making the comic for. Minis run the gamut from simple thrown together Xeroxes of people's work that they hope to publish in some other form, to the labor intensive "artist’s books". Most fall somewhere in between.

I worked on and off in a Xerox shop for the past 10 years while making my comics, and I suppose I’ve picked up a few tips along the way. The best way I can think of telling you how to do it is to describe how I would go about it.

ART
I've noticed lately that my style of cartooning, as well as that of a lot of my peers has developed around the fact that we would always be preparing our work for Xeroxing. To say it simply, tonality is out. To Xerox your comics, you're probably going to be working several generations away from your original art. Y ou've got black and white. Keep in mind the limitations of the Xerox. Strive to make a copy that looks good, even if it's not necessarily accurate to the original. This goes for color copying as well. There are 2 important things to realize that copiers can't do a) register with scientific accuracy, and b) copy flush to the edge of a page. This isn't the copier's fault. Nothing does. A nything that you see that is printed flush has been cut down. Y ou have this option.

COPIERS
There are many different kinds, and they all yield different results I suggest you try every single one you can possibly find. The office desktop copier or beat up one at the library may offer exactly what you want for a particular task.

A) Self service machines: in general, copy shops let the public use their "worst" copiers. These copiers are usually not made for large volume jobs, but may offer better photo settings, and the toner may not be as dense. A copier you can use gives you the greatest chance to experiment, and perhaps use unusual materials to copy onto.

B) Color copiers: Are complicated beasts. If you can find a self-service one, you are set. They offer all kinds of special functions, most of which are not very self-explanatory, unfortunately. They can often enlarge desig-
nated parts of an image, as well as stretching it, copying in negative, single colors or creating a mirror image.

Quality is a person-to-person decision. Almost all of them have "original recognition". This means they only copy the rectangular white edges of a page. Be careful of this if what you're copying doesn't have it. It is best to always put a piece of white paper behind your original, and let about an 1/8 of an inch between your original and the edge of the copier. If you are using a canon copier, I suggest you use the designation pen to designate any image you are going to copy. Color copiers also like to center almost everything they copy. This can be frustrating if you don't want it. They're digital. It's the price you pay. Color copiers are getting better every year, but will always have trouble with light originals, and with slight gradations. If your stuff looks like a comic book, you'll be fine. If it's a subtle watercolor, you're shit outta luck, especially if it's yellow. Anything that's light, or brown or even close to yellow, turns into bright yellow. Color copiers scan your image in little lines - just like a TV. For this reason, it's silly to use them to make clean B&W copies, especially if you have fine lines. It is possible to have tiny lines disappear in between, or to get Moiré patterns. Color copiers can now copy back to back, and on cardstock, but don't expect to be making a whole comic this way. It takes a long time, and the copiers still don't like to do it. They jam like crazy whenever the paper has any previous curl put on it. It's just their nature. If you want to put standard Xerox on the back of a color copy, do the color side first. Black toner will come off under the extreme heat and pressure of the color copier. The machine will be printing your black toner on the next hundred or so copies that go through it. OUCH! Good luck!

C) High speed/Large Volume copiers: (Those things they keep in the back) are the shit. If you want a nice crisp b&w copy on white paper, use these, but remember that these things are designed, and calibrated to copy text. The closer your comics look to text, the better you will fare (now you know where my ridiculous style came from). Some of them have trouble with large areas of black, some don't. Ask. I'll tell you in a minute how to set up your pages for them. A lot of places offer volume discounts as low as 2 or 3 cents a page. I love them because they are so fast. They can copy an entire ream of boring legal documents in about 3 minutes, think of how many 20-page comics that is!

D) Docutech is the new line of high volume copiers. I have never used one, but the results are amazing. Instead of copying your original, these machines scan them at about the same rate it takes to copy. They can then spit out as many copies as you want, then or later. The greatest thing about them is that they can add this great looking diffusion dither that makes things with tone (like pencils) look amazing.

E) Index Colors: Some copiers can copy in a toner that is not black. It's usually green, red, or blue. These copiers can be hard to find, and some places try to gouge you to use them don't let them charge you $5 for "set-up" that's bullshit. You can try to use the index color machines to make duotones by copying the black on top of them, but don't expect too much in the way of registration. But definitely screw around with them. They are cool. If you are really lucky, you may find a self-service one. I saw one at Kinko's once.

MATERIALS
I suggest you use anything you can get away with. I try to make as many of comics as I can on anything but white paper. If you've got a crap copier, try feeding anything you can possibly think of through it, but don't go too far. There are plenty of things that can cause thousands of dollars in damage to a copier. I should know. Don't copy any plastic besides copier transparencies. It will melt. Toner often won't land on paper that has too much of a tooth to it. It doesn't go down into the crevices. Copier toner is plastic that is being melted and ironed onto your paper, while it spins around a drum. Choose cool colors, and stuff, but if you are making large quantities, stick to a standard 60lb paper. Paper too heavy or too light may not stand up to the 2-sided process and may become a headache of jammed machines.

PROCEDURE
Is really up to you, but here's how I did my comics: 1) I copy and reduce all of my original art. 2) I cut out and paste up all of the originals into a little book, laid out exactly how I want to comic to look (I do most of my books 2-up on a page, I cut them, and then fold them in the middle) After doing this, you have 2 choices; 3) Copy your book directly from these mock ups, page by page. This makes your book only 2nd generation away from your origi-
nals, but you will have to collate the whole thing. 4) I would rather to make a Xerox of the paste-ups, and then
clean up any shadows with white out. I now have a set of “make-readies”. They can be plumped into any high-
speed copier with a feeder. My whole book will be spit out in a minute, ready to go. This is good for lots of rea-
sons. You can make lots more copies quickly, and you will probably be in a hurry, seeing a lot of you will be trying
to steal the copies. If you need to hand your copies to the man, you won’t have to worry about him screwing any-
thing up. He’s just copying your copies. Piece of cake. Yeah.

**COLLATING, CUTTING AND BINDING**

It all depends on how your comic is laid out, but here are some tips: I almost never have to collate, cuz of my little
make-ready deal. I just have to put my covers on. Make the cover different than the inside. It’s classy. You’re gonna
need a good paper cutter and long reach stapler. There’s probably no way a round it. You can spend a lot if you like.
Saddle staplers are super rad, but kinda costly. Long reach ones will never be perfect, but saddles plop the staple
right on the bend no matter what, no measuring involved. I’ve seen only a few cool alternatives to staples. Rubber
bands or cut strips of pantyhose. I’ve always wanted to use a sewing machine, but never have. I think you need a
super heavy duty one. The stitched zines I have seen look so nice. Bookbinding is a serious art. It looks so nice,
but can take a long time. Don’t ever let them bind your stuff at the copy store. It’s a rip-off. If you want to though,
let them CUT your stuff. Some Xerox or prints shops have massive hydraulic paper cutters. These things can cut a
ream of paper with precision accuracy. You can use it to get flush pages, and nice square edges. Ever notice how all
the pages in the middle of your comic stick out in the middle? Well you cut them off. It’s how real books are done.
Just bring your finished book in, and they will stack them up and cut off the edges. It makes them look sweet, and
shouldn’t cost you more than five bucks.

**QUANTITY**

Always make extras of everything. You’re gonna need more. You’re gonna screw some up, it’s a fact of life. You will
cut something upside down, etc. Save yourself the headache of having to run back to make 2 copies of page seven.
Think about the whole process, and how to make it easier on yourself if you need to make 209 more copies next
week.

**SCAMS**

There are new ways of cheating Kinko’s being told to me everyday. I’m sure all of you are looking to get shit for
free. Go for it. Go crazy. I’m not gonna tell you what to do. I know there’s whole zines out there devoted to the
subject. I’ve known people that have put on a suit, and walked into random offices and just started using the copi-
er. On the other hand, keep in mind that most of Mike Diana’s trouble came from the fact that he was copying
Boiled Angel on an elementary school’s copier.
FREE TRACES!!! scamming and steeling free photocopies!! "I have no money to publish, maybe I'll just make an e-zine," will never be an option again.

the scamming part will have to do with the Corporate chain, that rimes with Stinko's, I don't fuck with Mom and Pop shops. my favorite buttons on the xerox are enlarge, reduce (reduce shit and enlarge it over and over again, until it looks abstract, and soon the xerox will start seeing things that aren't even there) contrast, darken Lighten, Soft or sharp (on the newer ones) and photo, or printed text, options. I never close the top unless, just in case I want to move the shit around while it's copying, always have scissors, glue white out, and an assortment of different pens and markers, to do editing on the spot. the stuff I'm about to talk about can all be done on Computer just like most things these days, but I like to get my hands dirty.

#1 You you have to make frenz with the Kinkos bitter indifferent employee, Sometimes it's even the manager. They are usually younger, sometimes not. Maybe it's the obvious choice, of the greenhaired guy with all the piercings, but it might also be the fat dude with glasses, and pockmarks, but one thing is for sure, EVERY SINGLE KINKO'S has one. befrend, take advantage, fuck the system.

#2 Always, Always, bring an empty or Half empty backpack, or any kind of bag.

#3 Take 2 copy keys with you, when you go to make copies, Hide one under your bag, or books, make 10 copies on one, 10,000 on the other one, when you are done throw the 10,000 one in a fed ex package and throw it in the garbage or fed ex box, (the only time the staff watches the video cameras is if there is a robbery), or just take it home and start a collection (every time you do this, it cost's Kinko's like 60-100 bucks for those things), make jewelry and art out of it. Once again ALWAYS make sure you always bring a huge backpack so you can stuff them when you go to the counter,

#4 Slam the copy key after you are done making copies, on your palm, or on the floor, it will fuck up the counter, at which point they will just ask you how many you made, you say, 3 or 4, while 9000 are in your bag.

#5 Just walk out when you are done (this is what I do, but don't run, just walk, and be confindent like your doing no wrong, and no one will think twice, you get nervous or second guess yourself everyone will know what's up) I have yet to be chased or anything. If they do, don't run. just say you left your wallet in the car, or that your not finished you got a few 100 more to make.
#6 As for color copies, Drop off what ever you need colorcopled, when you come back to pick up, make one Black and white copy with the key, when you go to pay for it, pay only for that one b&w copy, so it looks like your paying for something, just in case who ever made your color order is watching, but chances are they never will be, the best time to deploy this attack is in mid-day during busy hours, always start early morning, so it'll be crowded by the time your work there is done.

#7 Get an office job, or a friend who has an office job and stay overtime, and use their mailroom, and xerox machine, do this forever until you get caught, when you get caught do not apologize.

say"That's right you fucker! I'm making ZEENS and shit, using your money and facilities for my personal GAIN!!!"spit in his face, or give him the finger, or do both, make sure yo make as loud and dramatic exit as possible. Impress all your co-workers, lead by example. Now you've fucked up your chances for ever working there again, or getting any recommendations. you don't need that job, or any other one like it. "hey it's a living." or"hey, someone's gotta do it, "is no longer an option.

I've deployed these methods at 5 different kinko's in my surrounding area (i crEated many zine's in my day). Anyways I was gonna riff on some of the dirty whiteout infested teknneks, but I think I'll let Aaron Comet bus do it for me instead, He's been at it a little bit longer than me.

---

Read about the Cometbus style

then read this

ON THAT NOTE, LEARNING HOW TO MANIPULATE IMAGES ON XEROX MAY SOUND EASY AND FUN, BUT IT'S JUST A TOOL. JUST LIKE WHEN PHOTOSHOP FIRST CAME OUT AND PEOPLE COULD MAKE SHIT INTO SOMETHING THAT LOOKED NICE, IT JUST A TOOL. LEARN TO DRAW AND TAKEN BETTER PICTURES, AND PRACTICE EVERYDAY, TRY TO DRAW, OR WRITE SOMETHING DOWN EVERY NIGHT, EVEN IF IT'S SOMETHING STUPID LIKE THIS, CACACRACK. THIS IS THAT I JUST DREW. DON'T THINK OF IT AS A MIRACLE WORKER, IT'S JUST A F*CKING TOOL. A GOOD IDIOT'S HAVE CREATED THEIR WHOLE CAREER ON PHOTOSHOP FILTERS, BUT IT GETS OLD QUICK, YOU SHOULD HAVE A CALLUS ON YOUR MIDDLE FINGER FROM GRIPPING PENCILS, YOUR EYES WOULDN'T BE HURTIN FROM STARING INTO A MONITOR.
WHEN ASKED TO CONTRIBUTE TO A FANZINE ABOUT XEROX ART TECHNIQUES, MY FIRST REACTION WAS, "I CAN'T GIVE AWAY ANY OF MY SECRETS." SECOND WAS, "FINALLY I HAVE A CHANCE TO TALK ABOUT THIS STUFF WHICH OBSESS ME." THIRD WAS, "WHO THE HELL WOULD CARE?" I STILL DON'T KNOW, BUT WILL PROCEED ANYWAY.

OR PURposely BREAKING WORKING MACHINES, ALL TO ACHIEVE CERTAIN EFFECTS. I AM METICULOUS, OFTEN DOING A HUNDRED COPIES FOR ONE GRAPHIC. WHEN I READ ABOUT TALKING ABOUT THE FOUR HOURS IT TOOK TO LAY OUT HIS MAGAZINE, I SIGH. IT TAKES ME FOUR HOURS FOR EACH PAGE, AND -

I'VE WORKED AT SEVEN COPY SHOPS, BUT THE ONE WHERE I TOOK TO EXPERIMENT MOST WAS A LITTLE ONE ROOM PLACE IN ALBANY, WHERE I WAS THE ONLY ONE. THE MACHINES WERE PITY LOUSY, BUT EACH IN THEIR OWN SPECIAL WAY. ONE WOULD TURN SOLID BLACK INTO A DULL GREY, ONE HAD SO MANY SPOTS ON THE XEROX DRUM, THE COPIES WOULD COME OUT PEELED. ONE DIDN'T PICK UP GREYS AT ALL AND ALWAYS JAMMED. SO, I'D START AT ONE MACHINE AND GO TO THE LAST, OPENING THE COPIER COVER TO BRING OUT SHADOWS AND SOME OF THE SUBTLE PARTS ON A PHOTO. I'D ROLL THE PAPER IN LIGHTEN IT OUT TO A HIGH CONTRAST WITH NO GREYS, THEN PURPOSELY JAM IT ON THE THIRD.

SCRATCHES ON THE XEROX DRUM WAS THE BASIS OF ONE. ONE PHOTO HEAVILY CONTRASTED, DOUBLE EXPOSED WITH A DIFFERENT PHOTO ENLARGED AND BROKEN UP USING A WAVY, SCREEN MAPED. A SELF-PORTRAIT. 6 WAS TAKING OUT ALL THE GREYS IN A PHOTO.

MACHINE BEFORE THE TONER SET, SO I COULD MOVE THE INK AROUND ERASING AND EMERGING IT, TAKE THAT TO THE FOURTH MACHINE, THE "GOOD" ONE, THEN REDUCE AND ENLARGE IT UP AND DOWN. FOR A WHILE FOR THE PICTURE TO DISTORT AND SOLIDIFY, LIKE AGITATING A PAINT IN THE DEVELOPER TANK TO BRING OUT THE DEEPER PARTS OF THE CONVENTIONAL PHOTO. JUST RIGHT THEN, START THE PROCESS ALL OVER AGAIN, ADDING A BACKGROUND COLLECTING PARTS OF THE PREVIOUS COPIES, REVERSING OR STRETCHING IT OR WHATEVER. ENOUGH TECHNICAL TALK. HERE'S A FEW EXAMPLES:

STARTING WITH 1, DOING EVERYTHING I JUST MENTIONED EXCEPT REVERSAL, I GOT 2. SIMPLY GETTING A VERY GREY LOW-CONTRAST XEROX CRIMPING IT UP THEN COPYING IT ON HIGH CONTRAST GAVE ME 3. A BROKEN MACHINE WITH GRAINY GREY COPIES AND

STRETCHING IT, AND ADDING A BACKGROUND TO PROVIDE A TEXTURE AND TONE, USING 4 I GOT TWO VERY DIFFERENT GRAPHICS ON THE FIRST 5. I BROUGHT OUT ALL THE DARKS TO GIVE A SOMEWHAT EFFECT SIMPLY BY DARKENING AND STRETCHING, YOU CAN VASTLY CHANGE FACIAL EXPRESSION OR "MOOD"—YOU CAN DO REJECTION AND SHAPE OF THE FACE. 6 IS FROM THE SAME GRAPHIC, BUT STRETCHED A DIFFERENT PARTITION. BOTH ARE EXPOSED WITH A REVERSAL OF A BACKGROUND 7. OBVIOUSLY, THESE ARE JUST A FEW EXAMPLES OF THE KIND OF THING YOU CAN DO.

IT SEEMS LIKE THEY MUST BE AN EASIER WAY OF EXPLAINING, BUT I COULDN'T FIGURE ONE OUT. I GUESS I DON'T HAVE TO WORRY MUCH ABOUT GIVING AWAY MY SECRETS WHEN NO ONE WILL UNDERSTAND THEM ANYWAY.

GOOD LUCK WITH YOUR OWN EXPERIMENTS!
SILKSCREENING
BY BRIAN RALPH

Large multi purpose art stores sell all sortsa basic screenprinting supplies. McLogan's or Commercial Screen supply (look at the back of this thing for contact info) are the places that have all the good shit. You *can't* get a small jar of paint or a $9.00 squeegee at this place, but you can get some fancy crap that is unavailable at the lesser two joints. Ask Ask Ask people who work at the commercial silkscreen supply shops.. there is usually one or two total experts on staff and they always are willing to give lotsa good advice.

Ok. Here we go with a list of the supplies you'll need.

**EMULSION**
This is the goop that you spread on the screen. It is a light sensitive goo. You take the screen and coat it (using coater bar, I'll talk about this in a minute) once you coat it, let it sit for a bit, in a couple of hours it'll be dry, and then it is ready to expose to the ultraviolet light (talk about this later too). If you wanna go the cheap route, get Hunt-Speedball Photo Emulsion. This is a product specifically for screenprinting. You get a box with two separate liquids in it - the emulsion itself, and the light sensitizer. If you're a little more concerned with quality and think you're hot shit, call up one of the big silkscreening supply stores and order Ulano QTX. This stuff is expensive, but not really. A gallon jug costs about $60-$80 bucks, but that jug will last for several months, and many many prints, so when you really think about it, it doesn't cost much at all. Maybe each time you coat a screen is 50 cents? c'mon moneybags.

**ULTRAVIOLET BULB**
Okay.. now that you must pick up the phone, Call McLogan, explain that you're a wanker and a harelip fuckoff, and that you heard of something called a No.2 Photoflood bulb for setting emulsion on silkscreens, and you want to buy one. The reason I say to explain that you're a wanker and know dick-all-fuck about silkscreening, is that if you get a helpful person, they'll steer you in the proper direction with helpful advice and some insights. I'm pretty sure it's a no.2 Photoflood you need. It may be a No.5 photoflood. In any event, ask the guy how long you need to expose the screen to this light, and write that down somewhere for future reference.

**SCREEN RECLAIMER/BLEACH PASTE**
This is the shit that takes the emulsion out. You coat it on and magically the emulsion will go away. If you're using the Hunt/Speedball emulsion, you can just use regular ol' Clorox Bleach to get it out. If you're using the Ulano QTX, you'll have to get Ulano No.5 Stencil Remover Paste. This stuff is kind of toxic, and so is the emulsion, but just if you eat it, but not so much if you smell it. You can touch it and all that, so it's no big deal. I have several jugs of this that i "acquired" from school. (from now on acquire means stole) So, don't worry too much about this bleach paste.

**MESH**
This is the stuff you need to make this all happen. This is the "silk" in the silkscreen. This can EASILY be acquired from your local art supply store. Or, if you don't wanna stretch your own screens, or you don't have the supplies right now to stretch your own, you can get a pre-stretched screen. What this will look like is basically a frame with a screen stretched on it. Imagine a painting stretched on a canvas, only the canvas is a translucent mesh, and you've got it. Art store.

**STRETCHER BARS**
This the frame that the mesh is attached to. It's basically just a square frame made out of wood. If you bought a pre-stretched screen, ignore this.
**CLAMPS**
this is what you need to attach the screen to the table. the clamps will make sure that the screen comes down in the same spot each time. EASILY acquired from you friendly art supply store.

**TABLE**
this is a table. you need a table, but it doesn't have to be fancy. it could be a piece of plywood on two work-horses. or it could be a card table. you just have to attach the clamps to it.

**DRYING RACKS**
racks schmacks. you just need a place to store paper, drying prints, or just use the floor, fancy pants.

**SQUEEGEE**
This the thing that pulls the ink across the screen. a couple different sizes is good. I think these can be acquired at Pearl. Get them about 2" smaller than the inside of your stretcher bars. If you got a pre-stretched screen, then a 9" hunt-speedball plastic squeegee will do just fine. Squeegees come in two types. Rounded edges and flat edges. The type you want depends on what you're gonna be doing. Get the flat edges if you're just going to be screen-printing onto paper or other flat and hard surfaces. Get the rounded edges if you're gonna be doing fabric or other soft stuff. If you just need a general purpose squeegee, get the rounded edges.

**COATER BAR**
This coats the screen with emulsion. it's kind of like a knife type of cup thing. i can't explain it. It's just a piece of aluminum that they sell you for a tidy markup. The coating of the screen needs to happen in a dark place, and it can be tricky, but it is easy once you get the hang of it. More on that later. Coater bars can be acquired at any decent art supply story.
INK
acquire it at yer art store. Textile Flavored. There are two different types of ink. There’s the normal water-based textile ink, which comes out totally opaque, and then there’s process ink, which just comes in Cyan Yellow and Magenta, but it’s very translucent, so whatever you print this ink over, a lot of that color will show through… like if you start with a blue ink, and then print process yellow over it, then wherever the yellow covers the blue, you’ll get a really great green… this is fun, and good. Yellow is the most useful for overprinting, but don’t take my word for it, mess with Magenta and Cyan, maybe you’ll do something neat.

BRUSH
a little type of scrubber brush is needed to scrub a dub the screen when you’re cleaning the emulsion and paint off. like a toilet brush or something.

SPRAY NOZZLE
this is the thing that puts a high pressure stream of water out… like you’d use to wash a car or your bike or whatever. You’re gonna use this to blast the emulsion out of the screen. Get it at the local hardware store.

DEGREASER
The screens need to be degreased after each use. So after you get the emulsion off, spray it with some dish washer liquid, keep that in a little bottle, and then scrub it with the brush, and wash it out. and while you’re at it, take a bath or something because you smell.

umm, that is really about it, except for the obvious, light so you can see, a couple rags, a keg of beer. oh yeah, and PAPER. lots of PAPER. acquire it.

THE ACTUAL HORRIBLE PROCESS
Get the design you want… do it up in black linework. If you’re gonna have a second color, do that up in black linework too. Try to avoid using zip-tone type dots for shading, and thin lines too - stick to bold-ish line work. Go to kinkos and have your linework put on to transparencies. Make sure you’re not using some weird frosted transparency either. They gotta be CRYSTAL CLEAR. If your work is larger than 8.5 X 11, then you’ll have to get multiple transparencies and piece the work together, securing it with clear scotch tape. Make sure the design will fit onto the screen you’re gonna use with about 1.5 inches to spare on either side, and about 2 to 3 inches on the top and bottom.

Now to prepare the screen. Get out your Hunt/Speedball photo emulsion, and mix it well in the quantities described (you’ll have to work fast, as it tends to start to gel in about 7 minutes.) If you’re using the Ulanomag crap, just scoop it out of the bucket - no mixing necessary. Pour it out onto one side of your screen, and spread it around evenly and smoothly with your spreader bar. Turn the screen over and do the same. What you’re trying for here is to get a full coverage on both sides that is as smooth and thin as possible. Once you feel you’ve got the smoothest coverage possible, take your screen into a dark place, lay it face down (the face being the part that touches the shirt or the poster surface) with a couple of blocks to keep it from touching the table top or whatever surface it is drying on. It will dry in about two or three hours.
Once you've got a dry screen, work in dim light, avoiding primarily UV rays. Lay the transparencies on the face of the screen, make sure the image is reversed (you're gonna be printing from the other side, and it will come out facing the right way - if the screen is face down, that is, the way you'll be printing, your image should look right. Common sense is your best guide here, as I find these instructions getting a little mixed up) get it all even, and how you want it, and then secure it with scotch tape, making it as flat as possible. If you have a large piece of glass, that will fit over the entire thing, use that to keep it flat. Flatness is key here, as shadows will make for soft edges on the screen, which will print as weird, and slightly rough lines.

Now you're ready for exposure. Set the UV bulb up into a lamp that is directly above the screen, and about 12 inches away. turn it on. I believe that the burning takes about 10-20 minutes. you'll know when it is done when, if you wet your finger, and rub it on a part of the emulsion near the edge (just as a test) the emulsion remains solid, and doesn't become tacky. When it is done, turn off the bulb, and take the transparencies off of the screen. Take it over to your bathtub, and turn it on cold. With a spray nozzle, like the thing you use to wash dishes or water your plants, spray the whole thing. You should see your design start to emerge as clear screen. Keep doing this - gently - until your whole design is exposed. Hold the screen up to the light to inspect it, and make sure your design is all there. If there are any particularly stubborn areas, you can gently massage the emulsion out of there.
Expect to fuck this up the first few times. Experiment with exposure times and find the optimum time that gives you a nice sharp design.

Good. now your screen has been burnt. Let it dry, use a fan or a hairdryer to speed the process if you have ants in your pants. Once it is dry, inspect the edges to make sure you don’t have any places where there is clear screen that shouldn’t be there. If you have holes or pin hole areas, you can go over them with a small dab of some emulsion on the face side, just expose it to the sun or the bulb, let it dry and fill in the area.

Now, clamp your screen to the table with those fancy-ass clamps you acquired. Tape your transparencies to one of the sheets of paper you’ll be printing on, and line it up so that it’s under your screen exactly where your design is. Match it perfectly, as this is how you’re gonna register it. Once you’re happy with the registration, lift the screen up oh, ever so carefully, and hold your paper in place. Put bits of tape along the edges of your paper – not holding it in place, just marking the edges. Now, you’ll align all your papers to these bits of tape, and your images will be perfectly aligned. For two colors, tear up the original pieces of tape, align the second color with your first color on the paper, put down new tape. And so on.

Once you’re sure your screen is ready to go, get some old newspaper, and use it as test paper. Put the screen face down on the paper, pour out some paint on it, and move it around, so that the squeegee will get a whole swath of paint over the entire design in one pass. Drag your squeegee firmly and steadily over the screen, to squeeze the paint through. Lift the screen smoothly up away from the paper using the edge closest to you. you may find that you’ll have to peel the naner away from the screen - do so in one smooth motion. Gaze upon your first screen-
print. YAY! Now, before putting the screen back down, run the squeegee back up the screen, "loading" it with paint. Then put your paper in, pull your squeegee down, and repeat.

You're on your way. Drink some beer. Screenprint. Try not to complain about your back hurting.

When you're all done with your farting around, you gotta wash the screen out, or the emulsion will set for good. First, wash off all the paint, and then scrub your screen with a bit of soap to clean it well, so that your remover can make good contact with the emulsion. If you use the Hunt/Speedball crap, pour bleach on either side of your screen, and scrub it around with your brush. Let it sit for a bit – 5 minutes or so – and then wash it out with your spray nozzle. You may need to do this a few time. If you're using the Ulano crap, get your Ulano No.5 Stencil Remover paste, use just a bit, dip your brush in it, and scrub your screen vigorously with it. Let it sit for a bit, and wash it out with your nozzle. Finally, give the screen one more good washout with dishsoap (to degrease it) and let it dry, perhaps with the aid of a fan or hairdryer. When it's all dry, you're ready to recoat it, and have at the whole vastly enjoyable process all over again. Aren't you just the lucky little squirt.

If you're thinking of taking your screenprinting to the next level, consider these two very important investments.

**WATER SOURCE**
The water source is needed to wash everything out, wash all the stuff. So, a tub is ideal, but some sort of basin will do depending on the size of the screens. Here is the tricky part. It is best if the water that comes out is in Hose form. Meaning, if you can somehow attach a garden hose type of configuration to the water supply you are in business. There needs to be some water PRESSURE, and a SPRAY type of thing. And a basin or tub to drain all the shit that you are washing out. So, I don't know how this hose gets attached to the pipes, but maybe somebody does. You know those sprayers that come with peoples sink to wash the dishes? Well, it needs to be like that, only STRONGER! Get a Garden hose hooked up to your tub, and you're in bizniss.

**LIGHT-TABLE!**
This is important. But it's not so hard to make, I think. It's just fluorescent light right? ok, so a table needs to be constructed that has fluorescent light bulbs underneath it shining upwards. I think it is as easy as going to home depot and buying some light fixtures and making the table. Yeah that's kind of vague. Well, I've never built a light table. But I will describe the one at fort thunder. It's just a couple of ultraviolet lights with a piece of translucent/frosted Plexiglas over the lights (this helps to spread the light evenly methinks) so, if anyone knows how to make a lighttable, shit, you are one step ahead of the rest of us. Getting the Lightbulbs is as easy as calling McLogan's and dropping a hundred or so dollars. They're 'spensive, but they last for quite awhile, so gofuckyourself. Figure out what size screens you want to use and then make the lighttable accordingly. Keep in mind that screens can be shot in parts, one section at a time, so your table doesn't need to be as big as the screen necessarily.

I hope it doesn't seem daunting, because it really is not hard at all. And it shouldn't take up too much space either. And jeez, it really doesn't cost that much either. I mean, you can make art with this stuff right? And people buy art for a lot of money. It takes a little time to get it right, so don't get frustrated. At first the prints are gonna be a little funky. You will fuck up quite a bit at first. Seriously. Many mistakes will be made. Don't sweat it, you'll get the hang of it. Just keep asking questions, and eventually you'll be allright. Once you get the SYSTEM down you'll be like Andy Warhol or some shit.
Print can be a fairly elaborate and involved medium, but by knowing a few basics you can produce a good looking, well put together book, and by fucking around with those basic ideas (really, there is no substitute for fucking around with things and trying different inks and papers and techniques) you can come up with something unusual and highly eye catching.

I'll first go into the reproduction of lineart for the guts of your comic. Then I'll talk about doing color, how 4-color is done, and a basic rundown of how I've been doing three colors on the covers of NON. Finally, I'll give some notes on how to find a printer, and what to pay, and a smattering on distribution, copyrights, and my own half-baked notions on “design”.

Before anything, lemmie say a few words about computers. Things are vastly easier if you do all your work on a computer. Learn PhotoShop, Illustrator, and Quark. This will save you a whole lot of time and money. For all you technophobes, let me assure you that however much you stay away from computers in your production, your work will end up on a computer at the printers, and you'll have to pay for photostats and scanning, and that will suck. The computer is your friend. It performs the same function as paste-up and photostats, and ruby lith did in days of yore, and it does it easier, faster, and, most importantly, better. So use a computer, knucklehead.

So, that screed taken care of, here goes.

**LINEART**

There are two ways to do this, both will yield good results, but the second one gives better results if you're a fucking snob like me. Both these methods use PhotoShop for scanning and conversion.

The first way to scan in your drawings are as 800dpi (dpi means Dots Per Inch) bitmaps. Most printers will tell you that 600dpi is okay, but they're wrong. 800dpi is the minimum acceptable resolution. So scan it in, and save it out as a TIFF. When you're naming your files, chose a convention that will be fairly obvious to the printer, such as p01.tif, p02.tif and so on. And that's it.

The second method is a bit more involved, but gives you better (let me assure you that nobody except other cartoonists will actually notice) image reproduction. Scan your art in as a 600dpi grayscale file. Convert it to a 1200dpi greyscale file. Now, you're gonna use the Threshold command. What this does is it turns all the pixels in your image either black or white (as a bitmap does) and it lets you play with the point at which the pixels go black. So for example - normal 50% conversion to bitmap, any pixels that are 49% black will be white. With the Threshold you can adjust it so that they are black. Play with it, you'll understand, it's pretty obvious. Simply go to Image>Adjust>Threshold and mess with that until you get the most exact reproduction of your lineart as possible. Then convert it to a 1200dpi bitmap file, and save it out as a TIFF.

This gives the best reproduction of your image that I'm aware of. It even does drybrush perfectly.

By the way. A note on Bitmaps. The reason you convert all your images to bitmaps prior to sending them is that bitmaps are the most basic form of an image. The pixels are either black or white, on or off. This means that you
have exact control over whether or not each pixel gets printed. Which is what you want. Control. The more you specify, the less the printer can fuck up.

Now, if your image contains grey tones like thin washes of ink or watercolor – such as a Ben Katchor drawing might – then you’d scan it in at 300dpi greyscale, and save it out as a greyscale TIF. Easy. The reason you only scan it at 300dpi is because when they print it, they’ll apply what’s called a halftone pattern to it, which essentially converts your smooth, continuous tone photo to a bunch of little dots. Take a magnifying glass to any printed greyscale art, and you’ll see the leeeetle dots. To make that halftone pattern, 300dpi is the maximum resolution they need. If you want an idea of what 300dpi looks like, open any magazine and look at any photo therein. That photo is 300dpi. So there you go.

COLOR (4-COLOR PROCESS AND SPOT COLOR)
The normal process where you give them an original piece of colored art, tell them to print it on a cover is the 4-color process (also called CMYK, for Cyan, Magenta, Yellow, and black...don’t ask why they didn’t use the first letter of black, that’s a whole nother story.) My personal feeling on 4-color process is that it sucks, and should be avoided at all costs. There is a very limited range of hues that can be reproduced correctly with 4-color. Royal blue is out of the question. Everything gets muddier. If you do a spectacular painting, and are okay with it being muddied down, use 4-color process. Me, I’ll stick to pantone spot colors.

But anyway, here’s how to do it. Scan your lovely painting in at 300dpi in the best color setting your scanner has (they vary from scanner to scanner). Then, convert your image to CMYK, and watch it get muddier. It will feel like a knife in your gut, but fuck it, it’s your fault for using CMYK, chump. You can do a few things to make your image look better. First of all, play with the brightness and contrast. Your image probably scanned a little dark, and will definitely print dark because of something called dotspread. (it’s basically where the leeeetle dots that get printed onto the paper bleed ever so slightly into the paper. When the whole image has little tiny bleeds, it gets darker than you intended it, because it turns a 80% linescreen into a 90% or something.. it depends on how porous the paper is. Anyway.) So, to compensate for the dotspread, jam the brightness up on your image by like 15%.. or something like that. Again it really depends on your printer, and the paper, and a lot of really random shit. This is another reason why I hate 4-color, the total lack of absolute control. You can also fool with the Hue/Saturation and try to get your image closer to what you actually painted. Fuck anything that’s blue – it’s pretty much a lost cause, it may look aqua or midnight blue, but it will never be that rich, vibrant blue that you laid down. Oh, and another factor of randomness – your computer monitor is no accurate reproduction of the color either, it’s only sorta what it’ll look like.

HOWEVER. If you’re filling colors into black Lineart, you stand a much better chance of getting four color process to do something for you... here’s the steps to make an image have crisp, relatively exact colors, and crisp beautiful lineart:

1 · Scan the lineart at 600dpi greyscale. Save this file as the “raw” scan, so if you make any fuckups, you can have this to refer to.

2 · Do brightness contrast on it till you get a nice clean page clean up any smudges, whiteout, etc.

3 · Crop the page to it's final size. DO NOT ever change the dimensions of the canvas after this step.

4 · Save this cleaned up file with a new name

5 · convert the file to 1200dpi greyscale (if you don't wanna go that high, you can get away with 800dpi, but I've found that 1200 is a teeeeeeeny (read: alot) bit more successful. NEVER NEVER use just 600dpi, as the jaggies in 600dpi are visible to the naked eye. NO shit. Look at any DC comic. they NEVER print higher than 600dpi because their printer “can’t” I don't get it. But don't make the same mistake as them. 800dpi at the very least, 1200dpi for the best results.
6 · Convert the file to BITMAP, save with a new name as a tiff, with LZW compression OFF. This is your final lineart file.

7 · open up the cleaned up 600dpi greyscale file.

8 · convert it to 300dpi greyscale.

9 · go to the CHANNELS palette. Drag the GREY channel to the little button on the bottom that is a dotted circle, then Select Inverse. Create a new Layer. Fill the selection with Black. Lock the layer. Go to the background layer, select all, fill with white. What you've just done: you've seperated the black lineart from the white background and put it on a new layer.

10 · convert file to CMYK

11 · Create layers UNDERNEATH the black layer and color them.. make sure you trap your colors beneath the black to compensate for bad press registration.

- Things I've found helpful with coloring:
  use the CMYK specifying device thing by double clicking the color palette - yellows sometimes get cyan in them and make them green.. this sucs. Red is equal parts yellow and magenta. um.. make sure to have no black in any colors. you can get really dark colors by properly mixing the CMY channels. It sometimes makes everything fit together better if you put a layer of one color.. I usually use yellow.. over everything, and give it a transparency of like 5% or so.. very light. It sorta blends everything. sneaky little trick, but very effective. It's almost like cheating it's so rad.

12 · when you're done coloring, save the file.

13 · Then turn off the black lineart layer, and compress the file and save under a different name. this is your final color file.

14 · NOW. this is why since step 3 you havn't changed the overall canvas sizes.. Using Quark, place the color file, and then place the black lineart file on top of it. Align them both to the upper left corner. then save the quark file.

15 · what you'll send to the printer. Quark file, lineart file, and color file .

16 · Have a beer, you're done.

So yeah. CMYK gets the job done, but does it look tip top? No, not at all. It looks acceptable. If you really wanna look snazz, you gotta go with the pantone SPOT COLORS. yes yes yes.

Most of the covers I've done are printed with spot colors - NON, Last Lonely Saturday, Cave In.. all spot colors. I did the Slow Jams cover in CMYK, and it looked like SHIT next to Dave's original painting. You didn't know the difference, but it was killing me. Spot colors are wonderfuckingful - they give me absolute control over how the colors in the image will appear. Spot colors are inks that are mixed to a specific color, thus nearly any color is possible. Very wonderful. There's a book of color swatches called a Pantone Guide, that you can get for about $80 at any art store. It's a bitch of an initial outlay, but it lets you see exactly what the colors will look like when printed on both coated (shiny) and uncoated (matte) stock. If you don't wanna buy one, just have an idea of what colors you want to use, then go into an art store, and ask to have a look at the Pantone Guide, and rifle through it quickly and write down you're the color codes you want.

The way I do the NON covers is essentially digital equivalent of cutting scads of ruby-lith behind the lineart.
Easy, cheap, but very time consuming. I only work with three Pantone colors, and I think this is a great way to get some striking images and color combinations. Also, it keeps the lineart very crisp, as opposed to reproducing it at 300dpi, as with 4-Color. Get a magnifying glass, and take a look at most comics printed in magazines, the lineart doesn't have a solid edge, and I hate this.

First of all, I scan my cover into PhotoShop as a 600dpi greyscale, upsample it to 1200dpi, and convert it to a 1200dpi bitmap image. I save it out in a folder called “cover” as a TIFF. Then, I quit out of PhotoShop, and open up Illustrator.

In illustrator, I use the File>Place command, and import the cover file to my document. Now, the cool thing about placing a bitmap in an illustrator file is that it's transparent. Like the lineart is totally opaque, and everything else is transparent. Which is wonderful.

So, now I'll open my layers window, and create a new layer underneath the lineart layer. I Lock the lineart layer so's you can't accidentally click it and move it. Using the magnifying glass, I'll zoom in really close and with the pen tool, I'll create shapes of color behind the lineart.

I control the color percentages like this. Open up Windows>Swatch Libraries>Pantone Coated. Select a color that you think you'd like to use. If your shape is selected before you click on the color, then the shape will fill with your color. Great. Now open the Color window, and you'll notice that there's a slider of your color that goes from 0% to 100%. Slide this up and down while your colored shape is selected, and it will lighten or darken.

So, I do this until I have my image totally filled with three different colors I wanna use. It's a long process of drawing silly little shapes, but just listen to some music loudly on your headphones and zone out while you do it.

When the image is colored, I like to fool with the colors and try different ones out. There's a function Edit>Select>Same Paint Style. If you've done everything right, then you should be able to select a square of say.. yellow.. and do Edit>Select>Same Paint Style and every yellow, no matter what the percentage, will get selected. Then if you click on like, green, in your Pantone swatches, they'll all change to green, and keep their respective percentages. Very cool. This will only work, however, if you've colored everything with Pantone colors, and not RGB or CMYK colors. So take warning.

A note about your colors. You'll select certain Pantone spot colors and decide how they look in your composition. Disregard the Pantone codes, because your computer monitor changes how they actually look. If you like the color, whip it up in your Pantone Guide, and find the matching color in there. That way you specify from an actual printed swatch rather than from a computer monitor, which is so very very very different that a printed sheet of paper. Your monitor gives off light, the colors are lit from behind, however when a color is printed on a sheet of paper, the light is reflected. Thus the colors on your monitor will look much more luminous than the printed colors - the Pantone guide is really an indispensable tool if you plan on doing a lot of this sort of work.

As far as the number of Pantone (or, as the printers like to call them "spot" colors) it doesn't cost too much to add an additional color.. talk to your printer if you wanna do more than three colors. NON no4 was printed with 5 colors, and it wasn't too expensive.

If you're using any fonts, you've got to change them to outlines so you won't have to deal with Font problems when you ship the thing to your printer. SO, unlock everything, select all, and do Type>Create Outlines. This turns all your fonts from a font file into Illustrator Paths. It will look jaggier and more fucked up on your screen, but it prints out just exactly the same, and you don't need to worry about your printer having that font installed on their computer.

So when you're done, Select>All, Object>Lock and save it out as a final file. You've colored your cover.
When you ship it to the printers, include a note file with your color specifications. Basically like this:

- Brown = Pantone 1675u
- Pink = Pantone 1767u
- Yellow = Pantone 121u

This will clue them into how you want it printed. Remember that the more you specify, the less the printer can fuck it up for you.

**FINDING A PRINTER**

If you're in North America, you have two options: Local and Canada. Local Printers are good because you can just open the phone book, make a few calls, find a low price, drive your work over, and then do an on-site press check when your stuff is coming off the presses. This is a wonderful luxury, and you should do this whenever possible. Canada, on the other hand, is good because you'll pay anywhere from 20 to 50 percent less (thanks to the exchange rate and government subsidizing) than you would in the US. And they do quality work. Quebecor Printing has done NONno3 and no4, and they do tons of other comic books, so it's familiar territory for them. However, if you're gonna go Local, make lotsa calls to find the lowest price. You'll find that different printshops quote wildly different prices - this is because they're set up mainly to do one thing - anything out of their realm costs you dollaz.

A great source for comics savvy printers is the Staros report, which is a great source of all sorts of comics contacts and you can pick up at most indy comic stores. It hasn't been in print for a few years, but it can be found with a little looking. If no local shops carry it, contact Top Shelf (www.topshelfcomix.com)

**PAPER STOCK AND BOOK SIZE**

Tell your printer how many pages you're gonna have, and what sort of cover stock and how many colors you're gonna have on the cover. The best way to figure out paper stocks is to send samples to the printer with post it notes on them (simple notes that say "this cover stock," "this text stock," "this finish on the cover," etc.) and get them to price it all out for you and fax you a quote.

Size matters. Very simply, there are certain sizes of paper stock. If your book doesn't fit neatly on it, say it's larger than the paper stock by 1/2" then the printer will have to go to the next largest paper stock, and perhaps use a larger press as well. If you stay in the vicinity of normal comic size, you're fine. The bigger you get, you run the risk of moving to a new paper stock. Ask your printer. Bug them, harangue them, get your money's worth. Find out how large you can go before you're into a new paper stock.

**SENDING IT TO THE PRINTER**

First, make sure all of your TIFF files are not saved with LZW compression. While LZW is a wonderful thing for saving files locally, as it makes them shockingly smaller, for some reason or another, the printer can't output them to their machine that makes the film for the press. If you've got LZW on your files, the printers gonna have to open them up and resave them, and it'll cost you extra. Next, you wanna put the whole thing on a Zip disks, or better yet, if you have access to a CD burner, burn it. Make sure it is clearly organized. Send the disks to the printers with clear notes detailing all your specifications. If possible, make a dummy book and send that too, so they can have a hard copy of page layout and order.

After you ship your pages off to the printers, they'll send you back what's called a Blue Line. This is basically your entire book printed on this light-sensitive material that makes all your lineart look blue. You'll basically go through this, and find any errors, correct them on your original files and send them back to the printer. If any pages are misaligned or out of order, or have weird smuges or things missing, tell your printer how to fix them, or just fix them yourself and send a new file to the printer. Spend quite awhile double-checking the bluelines, and if at all possible have someone else look them over for glaring errors, spelling mistakes, splotches, and whatnot (you've
been staring at these same lines for so long, they've no doubt started to blur together.) Once you've decided it's perfect, give the printer the okay, and they'll send it to press.

You'll also get a sheet color separations for your cover, which will look nothing like your final printed image in terms of color. The separations are all done in CMYK, so if you're doing three color you'll probably have a Black sheet, a Magenta sheet, and a Yellow sheet or something like that. Look at each sheet, make sure everything is where it should be, and that you haven't left anything out. If there's something wrong, bug the printer, it's okay, that's why you're paying them. If everything's okay then give them the thumbs up, and they'll print yer book.

**COMING UP WITH THE CAY-ASH**

Ok, so you got your prepress, you got your printer, now all you need is the cash. This is where it actually gets creative. Basically you get the money any way you can. You really want to have the money before you go to press, cause if you're in this for the long haul, you *really* wanna have a good relationship with your printer so's you can get some help when you're actually in a jam. A favorite money-getting technique of mine is asking friends with money for a loan, and proposing a payback schedule to them - once a month (the fifteenth, so's you don't have to come up with rent AND payback). You can also ask family members for a loan or a gift, friends, savings, bake sale, the possibilities are endless. But I've always managed to get at least one friend who can loan me what I need, so I've been lucky. You can get the money - it's there to be had - you just gotta have the nerve to ask for it.

Also: grants. There's the Xeric grant, possibly the most well known grant for comic artists, but there are lots of other grants available.. local and national. Look in artist reference books for lists of these.

The downside of this money you'll be spending on printing is that you probably will not make it back. However, if you're in it for the long haul, things will work out. I haven't made dime one on anything I've published, and I am still nowhere near supporting myself on comics, but one day.. ah, who knows. Say a prayer for me to the fickle dollars of the American Consumer.

**NOTES ON DISTRIBUTION**

Distribution, is key. You're gonna have to hustle the old fashioned way. What I did to get the ball rolling was just to go to comic-conventions like APE and San DiegoCon, WonderCon, SPX, and give the thing away to artists and publishers and basically anybody with any cred at all. I didn't just pass it out to random people cause that is damn close to just throwing it away, but if you give your book to artists and publishers, and just put your book in hands, it will get read, eventually, by someone, and people (for better or worse) will talk about it, and with any luck a bit of buzz will develop. This is important. Also go through the normal channels with distributors, call them, find out submission procedures, and do what they want.. (the Staros report has a good list of distributors, too. oh, and Punk Planet had a good section called DIY files and it was all about zine/comic distribution and self distribution, and it was quite informative and filled with usable info, it can be tracked down on the internet or something with a little work.)

A key element here is geography. get your book into as many stores as you can. Send samples to indy comic book stores all over the country (again .. the Staros Report, and there's a great list on www.drawnandquarterly.com ), and follow up all mailings with calls, and more calls, and then order submission and fulfillment. Harassed fucking work, and no immediate *monetary* rewards.. by immediate, I mean within two or so years. However, you do get credibility, and you get recognition, an people see your work, and start to expect more, and you develop a few fans, and eventually (in theory) you get enough people buying your book that you can give your current employers the big FUCK YOU, and leave for a life of bare necessities and the sheer terrifying hell of drawing comics.

It takes attention to quality and perseverance and distribution, and eventually it will reach the audience it deserves. Just keep plugging along.
COPYRIGHT CONCERNS
As far as the copyright worries go - fuck it. It is going to do you more good to get your work exposed and (possibly but fairly fucking unlikely) copied than it will to keep it under wraps. Don't be too precious with your work. No one comic will make or break you, if you're good at what you do, you'll endure.

PRINTER SPEAK
Have all of these things figured out before you call a printer, and you won't sound like such a jackass. If there's something specific that you want a quote on, and you don't know how to ask for, try to find a sample of it, and send it to the printer.

QUANTITY: How many books do you want? Realistically, you can plan on selling about 1500 in your first year or two. If you order more than this, they will sit in your basement. Which is OKAY. You'll eventually get rid of them if you keep pushing your wares. Here's a sobering thought: to make any real profit, you'll have to sell like 5000 books. Ech. The pain. I usually get 3000 books printed - that way I can fill initial orders, and have some sitting around for reorders.

SIZE: the dimensions of your book in inches or centimeters.

TEXT: the guts of your comic.. the actual pages between the covers. The paper thickness is usually referred to in "pounds." It starts at 50 pounds (that's the thickness in the NON) and goes up.

COVER: Duh. The cover. The thickness here is referred to in "points." I believe NON no3 and no4 have 8 point covers.

SADDLE-STITCH: binding the comic with a staple or two in the middle. This is how most 24 page comics are bound.

PERFECT BOUND: A square binding.. like a graphic novel. This is how most comics of 64 and up pages are bound.

When speaking about printing, use of the word "OVER" can get you instant credibility. If you're talking about a sheet of paper that will be printed with a single color of ink on either side, it's "one over one" which basically means "one color on one side, one color on the other". If you're talking about a piece of paper, usually the cover, that will have 3 colors on one side and one on the other, say something like this: "I wanna print the cover three over one," and the printer will think you know what you're talking about.

So, I might call my printer and say that I'd like a quote on a book. It's Four and one eighth inches wide by six and three eighths inches tall. It's 80 pages, the text is one over one on 50 pound paper, and the cover is three over one on eight point stock. I'd like an ultra-matte finish on the cover, and I want the book to be square bound. Also, I'll supply everything on disk. Please give me a quote for 3000 copies and 5000 copies.

They may ask you a few additional details, but that's really the nuts and bolts of it.

SOME LAST WORDS ON BOOK “DESIGN”
The most important thing in making books or comics or anything, for that matter, is to fucking ignore the status quo. You've spent months laboring over that comic, why in the world would you print it on crappy paper with that flimsy glossy standard comic cover? Don't make it look like every other crappy rag out there. Mainstream comics are printed the way they are because it's the cheapest way, not because it's the best way to present the art. Comic publishers have taken the cheapest route for so many years that nobody even notices anymore. Ads on the same
page with art, mis-registered colors, paper that browns in a year. W hat the fuck?

Treat every comic like it may be the last thing you’ll ever do. Imagine you’ll die after you finish it, and this will be your last words on this green earth. Make it fuckin nice. Uh? Look at outside sources! Go into bookstores and look at the paper that the paperbacks are using. Look at the fancy coverstocks and diecuts and coatings. Go to the magazine stand and check out the art magazines. Aim for the coolest damn thing you can imagine. Presentation is part of the comic and it should never be skimmed on. You will only regret it in the end. Ask your printer lots of questions. They will tell you if it can be done and for how much. Too expensive? Ask them how to make it cheaper. You are going to potentially spend thousands of dollars with them. They will take the time to make you happy.

Never put ads in your book. Are you making art or an infrastructure for commerce? Do you really need that $50? Borrow it, work a day at your crappy job, pay it back. Nobody wants to see an ad for anything.. we get enough of it on TV, why continue it in something you can actually have control over?

Always Always Always think, "Will this look good ten years from now?" Will it endure, or are you making a play to the fashion of the times, are you mimicking some trend? You’ll regret it in a few years. You’ll be embarrassed to show it to people, cuz suddenly nobody’s wearing baggy pants or big goofy fly glasses with yellow lenses. Unless you *want* to make pop candy, which certainly has it’s place. I suppose, the point is, be *aware* of your decisions, make them for the right reasons, not cuz you wanna be down with whatever.

From a design standpoint, it’s probably best to ignore everything that has been done in comics before the printing of your book. Fuckall, right? Make something new. Don’t copy somebody else. If your idea makes you feel uncomfortable or downright scared, you’re probably on the right track. Aim for beauty, aim for art, and don’t worry about commerce and cash.. that won’t matter a hundred years from now, whereas your work might endure.

If you get some crazy idea like using red ink on orange paper and having the whole thing fold like a map, do it! Don’t ever listen to a comic store clerk about format! He’s just worried about how to rack your comic next to a bunch of superhero comics, and he’s probably a moron anyway. You don’t need him despite what anyone says. If you want to make your comic three feet tall by one foot wide, do it!

Picture the best possible form of your book, ask yourself why you think that’s so good, challenge your ideas, try to evolve to a higher concept, a more beautiful design, a book that before a person even picks it up, they’ll be stunned by it’s beauty, it’s innovation.. you know. Just make it look great, is that so hard?

All of this with one important caveat. The design of the book must serve the content of the book. Above all, strive for this, and you’ll do well.

AND THERE YOU GO
You can email me at jordan@reddingk.com if you’ve got any questions. Also, Tom Devlin, the designer and publisher of Highwater Books will answer any and all queries at tom@highwaterbooks.com
CONTACTS

SILKSCREENING
Commercial Screen Supply Inc.
6 Kiddie Dr.
PO Box 212
Avon, MA 02322
Call 1-800-227-1449, ask for a catalog.

McLogan Supply Co. Inc.
2010 Main St.
Los Angeles, CA 90007
1-213-749-2262
www.mclogan.com
mcloganmail@earthlink.net
ask for a catalog

PRINTING
Quebecor Printing Lébœufon
8000 Blaise-Pascal Avenue
Montreal (Quebec) H1E-2S7
Call Olga Pereira at (514) 494 5461

A HELPFUL GUIDE TO MANY THINGS
The Stars Report
Chris Staros
Top Shelf Productions, Inc.
PO Box 1282
Marietta, GA 30061-1282
USA
Fax: (770) 427-6395
E-mail: staros@bellsouth.net

A SHORT LIST OF LARGE DISTRIBUTORS

Last Gasp
777 Florida St.
San Francisco, CA 94110
(800) 366-5121

Cold Cut Distribution
475-D Stockton Ave
San Jose, CA 95126
1(408) 293-3844

Diamond Comics Distributors
1966 Greenspring Dr., #300
Timonium, MD 21093
1(410) 560-7100

FM International
913 Stewart Street
Madison, WI 53713
(608) 271-7922